**SPIROLA**

Spirometry Longitudinal Data Analysis

Version 2.0
(Updated: May, 2009)

User Manual

Surveillance Branch
National Institute for Occupational Safety and Health
Centers for Disease Control and Prevention
Morgantown, WV 26505, U.S.A.
Tel: 304 285-6031/5754
E-mail: spirola@cdc.gov

**Disclaimer:** This software is provided to assist health care practitioners in their management of occupational medical monitoring programs using spirometry. The software is only intended to assist the user in assembling the information required to make medical decisions, but cannot be substituted for competent and informed professional judgment. NIOSH does not warrant the reliability or accuracy of the software, graphics, or text. The users need to be aware of applicable federal, state and local laws and regulations that may impact utilization of this software.
# Contents

1. **Background** ............................................................................................................................ 1

2. **SPIROLA Installation** .................................................................................................................. 2

3. **Operating Instructions** ............................................................................................................. 3
   - 3.1 Start and Close SPIROLA ......................................................................................................... 3
   - 3.2 Open Datasets and Data Input ................................................................................................. 3
     - Open existing spirometry database ............................................................................................. 3
     - Spirometry data input and format .............................................................................................. 5
     - Open or locate administrative database .................................................................................... 7
   - 3.3 Select a Group for Evaluation .................................................................................................. 7
     - Display invalid records or missing values .................................................................................. 7
   - 3.4 Individual Evaluation Menu .................................................................................................... 8
     - Monitor FEV\(_1\) in an individual .................................................................................................. 8
     - Monitor FVC in an individual ...................................................................................................... 10
     - Monitor percent predicted values in an individual ...................................................................... 11
     - Display summary report ............................................................................................................ 12
     - Display multiple charts ............................................................................................................. 13
     - Search for an individual by name or identity number ................................................................ 14
   - 3.5 Group Evaluation Menu .......................................................................................................... 14
     - Monitor longitudinal data precision in a group .......................................................................... 15
     - Monitor mean FEV\(_1\) and FVC values in a group .................................................................... 15
     - Display multiple charts ............................................................................................................. 16
   - 3.6 Print Menu .............................................................................................................................. 17
   - 3.7 Risk List Menu ........................................................................................................................ 18
     - Screen for individuals at risk of developing respiratory impairment ........................................ 18
   - 3.8 Tag Menu ................................................................................................................................ 18
     - Tag individuals for further evaluation or intervention ............................................................... 18
   - 3.9 Intervention Menu .................................................................................................................. 20
     - Design and review intervention strategies and questionnaire data ........................................ 20
   - 3.10 Quality Control Menu .......................................................................................................... 23
     - Analyze quality grades assigned by a spirometer ...................................................................... 23
   - 3.11 Options Menu ........................................................................................................................ 23
     - List of options that can be changed from default ........................................................................ 23
     - Referential rate of decline .......................................................................................................... 24
     - Within-person standard deviation ............................................................................................. 24
     - Critical limit curves ..................................................................................................................... 25
     - Show height in inches or centimeters ......................................................................................... 26
     - Display values of an observation on the chart .......................................................................... 26
     - Remove outliers from a longitudinal analysis ............................................................................ 26
     - Customize the reference equation for LLN and predicted values ............................................ 27

4. **Methods of Evaluation and Interpretation of Results** ............................................................. 28
   - Interpretation and suggested actions ............................................................................................ 28
   - Risk List evaluation procedure .................................................................................................... 29
   - Suggested intervention measures ............................................................................................... 29

5. **Theoretical Background** ........................................................................................................ 30
   - Evaluation of FEV\(_1\) precision in a group ................................................................................... 31
1. Background

Monitoring of lung function in at-risk populations enables the identification of individuals with excessive decline of lung function. The spirometry test of forced expiratory volume in one second (FEV₁) is the measure best suited for monitoring changes in lung function over time. An excessive decline in FEV₁ over several years can indicate development of lung disease and has been shown to be associated with increased respiratory morbidity, loss of productivity at an earlier age, and increased mortality.¹⁻³

The Spirometry Longitudinal Data Analysis (SPIROLA) software is an integrated visual and quantitative tool to aid in monitoring lung function in individuals participating in spirometry-based health monitoring programs. To ensure that individuals with excessive decline in lung function can be identified accurately and in timely manner, it is important to maintain acceptable precision of the longitudinal spirometry data. In order to maintain data precision at an acceptable level, SPIROLA enables the user to monitor longitudinal data precision and spirometry quality grades for the monitoring program, this provides also a basis on which to determine an appropriate limit of longitudinal decline in individuals.⁴⁻⁶ SPIROLA may help to preserve lung function through identification of excessive decline followed by appropriate intervention. The intervention function helps the user to obtain information on potential risk factors, and plan, record, and evaluate the effect of intervention strategies. SPIROLA provides the following functions:

For an individual:
- It monitors the level of FEV₁ and FVC in relation to criteria for assessment of cross-sectional data: the lower limit of normal (LLN) (i.e., the lower 5th percentile) and the lower 0.1th percentile (approximately comparable to 60% predicted).
- It monitors FEV₁ change over time in relation to criteria for assessment of longitudinal changes: the limit of longitudinal decline (LLD).
- It provides interpretation of the rate of FEV₁ decline and data variability in an individual’s summary report and suggests actions to prevent further excessive loss.
- It enables to plan, record, and evaluate intervention measures.

For a group of individuals:
- It monitors longitudinal data precision using the pair-wise estimate of within-person variation \( s_p \) (absolute) or \( s_r \) (relative).⁴⁻⁶
- It monitors group means for observed, predicted and z-score for FEV₁ and FVC to enable the user to identify time-related changes taking place at a group level.
- It monitors statistics on the spirometry quality grades, as provided by a spirometry system, as a percentage of testing sessions that do not meet the 2005 ATS/ERS criteria for acceptability and repeatability, overall and by individual technicians.
- It provides statistics and lists of individuals whose lung function tests fall below the LLN and whose rate of lung function decline and variability may be excessive.
2. SPIROLA Installation

SPIROLA runs on PC with Microsoft Windows system. For detailed software requirements see Appendix.

2. Click Software Download to download SPIROLA.
3. Click Run button on the File Download window to start setup procedure. (If a warning "Publisher could not be verified" appears, click Run button to continue the installation.) If Run does not work, click Save on the File Download and save the setup file on the local C: drive (e.g., C:\SpirolaSetup) and then run on the local drive.
4. Follow instructions specified by the installation procedure. User needs to read and agree with a DISCLAIMER to install and use the software. Click Next> to proceed.
5. The Select Installation Folder window will appear, as shown below. By default, SPIROLA is installed into C:\SPIROLA folder. The user can override this default setting by designating an alternative location. Click Next> to proceed.

![Select Installation Folder](image)

6. Follow the setup wizard instructions to complete the installation. On completion, an Installation Complete window will display message “SPIROLA has been successfully installed.” Click Close to exit.
7. SPIROLA item will be added to the All Programs menu on the Windows Start menu, and a SPIROLA icon will be created on the Desktop.
8. When installing or uninstalling SPIROLA in future, the administrative database SPIROLA_Admin.mdb previously created by SPIROLA will be automatically deleted if it is located in the same folder as SPIROLA software. For instructions on how to protect an administrative database created previously by SPIROLA, see section 3.2 below.
3. Operating Instructions

3.1 Start and Close SPIROLA
To run SPIROLA, double click the SPIROLA icon from the Desktop, or click the SPIROLA program via Start > All Programs > SPIROLA.

A SPIROLA start screen will appear, as shown below. To close SPIROLA, on the File menu click Exit, or just click the close button in the right upper corner of the window.

3.2 Open Datasets and Data Input

Open existing spirometry database

The first step is to open a SPIROLA dataset. For demonstration purposes the SPIROLA package includes a demo dataset (C:/SPIROLA/DemoDataSet.mdb). See next section for instructions on how to create user’s own SPIROLA database.

1. On the File menu click Open Database, as shown below.
2. A window will appear as shown below. Click on the desired .mdb file (for example, SPIROLA.mdb). If the dataset file is not in the current folder, click on the Look in list, and then double click the drive and folder that contains the .mdb database file. Click Open to proceed.

3. Click on a desired data table listed under Select a Table from Current Database as shown below and then click OK to load the whole dataset into SPIROLA.

Note: User can select a subset of individuals whose last test is within a specified period. To do that, click on Last Test and select the appropriate period for the most recent test. SPIROLA will process the subset only during the current session. To apply the settings next time SPIROLA is started, check Remember Selection.
Spirometry data input and format

SPIROLA requires demographic and spirometry data stored in or transported to a Microsoft Access database (.mdb) as a data table. Tables sorted by ID and TestDate will be processed faster. Each record should contain information on a single spirometry test with the following fields and a specified type. Fields can be in any order and variable names are not case sensitive.

The following variables are essential (must be included) for the SPIROLA analysis:

- **ID** – A text field (alpha numerical) to uniquely identify a tested individual (i.e., if two different databases have similar values for ID field, but related to different individuals, see Section “Open or locate administrative database” below). Also, to speed up the data processing it is preferred that ID field contains only numeric values, but it is not a requirement.
- **Sex** – A text field to store “M” for male or “F” for female gender
- **Race** – A text field to store “M” for Mexican-Americans, “B” for African-Americans, or “W” for Caucasians and other groups. This variable is used for selecting the appropriate set of reference equations.
- **Age** – A numerical field for age in years at a test (optional if date of birth provided)
- **BirthDate** – A date field (format: mm/dd/yyyy) to store date of birth (optional if age is provided). This field allows more accurate calculation of age, (e.g., 45.5 vs. 45)
- **Height** – A numerical field to store height (cm) measurements of a tested individual

SPIROLA Ver. 2.0
• FEV1 – A numerical field to store best FEV\(_1\) (mL) value of a tested individual
• FVC – A numerical field to store best FVC (mL) value of a tested individual
• TestDate – A date field (format: mm/dd/yyyy) to store test dates

The following variables are optional for spirometry quality analysis:

• FEV12 – A numerical field to store second best FEV\(_1\) (mL) value
• FVC12 – A numerical field to store second best FVC (mL) value
• QFEV1 – A character variable for FEV\(_1\) quality grades (if available)
• QFVC – A character variable for FVC quality grades (if available)
• QTest – A character variable for session quality grades (if available)
• Oper – A character variable for operator (spirometer technician) code or name
• Provider – A character variable for a provider (e.g., a van service)

The following name variables are optional and are needed for a search by name:

• Last_Name – A text field (Surname/family name)
• Middle_Initial – A text field (leave blank if not available)
• First_Name – A text field

Inclusion of names in the database enables the user to identify an individual by name using Search for a Participant function in the Individual Evaluation menu. Also, if both Last_Name and First_Name are provided, the reports will include full names of tested individuals.

Additional fields containing, for example, weight, smoking status, cigarettes/day, asthma status, or respiratory symptoms data can be added. These data will be shown at the bottom of individual’s FEV\(_1\) chart, but will not be used in the analysis.

Importing data into SPIROLA

ATS/ERS guidelines on Standardization of Lung Spirometry, recommend a standard format for databases generated by spirometers (Eur Respir J 2005; 26:319-338). All the variables specified by SPIROLA are defined by the ATS/ERS guidelines to be included in the standard database. At this stage the user needs to convert the spirometer-generated database into an Access database, following the guidelines for format of the variables, described above. The user can use Microsoft Access software to create or import the spirometry data. To avoid data loss, all .mdb files should be backed up.

EasyOne Database Import. SPIROLA provides utility to import the data generated by EasyOne spirometer. To import the data on File menu click on Extract Data and on From EasyWare to access the import software. Click on Help and follow the instructions provided. Future SPIROLA revisions will enable importing data from some of other standard databases as well.
Open or locate administrative database

Administrative database, SPIROLA_Admin.mdb, contains information that SPIROLA needs while processing the spirometry data. More specifically, the administrative database stores the questionnaire results and intervention plans for individuals participating in spirometry monitoring (i.e., records created using the Tag and Intervention menus). To avoid data loss, the administrative database, as well as the SPIROLA database, should be kept in a secured location that is regularly backed-up.

By default, when installing SPIROLA, the SPIROLA_Admin.mdb database is created in the installation folder and an existing SPIROLA_Admin.mdb is deleted. Therefore, when installing or uninstalling SPIROLA, the user should safeguard an existing SPIROLA_Admin.mdb database that contains questionnaire or intervention data. This can be done by creating or moving SPIROLA_Admin.mdb to another folder or by renaming the administrative database (e.g., SPIROLA_Admin_textile.mdb). To create a new administrative database in a different location or to rename it, on the File menu click on Select Administrative Database (see above). A window will inform the user of the current location of the administrative database (see below). Click on Create New Administrative Database and select a new location or rename the database. By doing this, the SPIROLA copies empty SPIROLA_Admin.mdb from the Template_Files folder into the specified folder (i.e., the copied administrative database does not have any questionnaire or intervention plan records). To copy an existing administrative database into another location, the user should use Window Explorer. The Select Administrative Database function is useful when an administrative database is shared by several users and needs to be located on a shared disk space or in a secured location.

![Select Administrative Database](image)

3.3 Select a Group for Evaluation

Display invalid records or missing values

By default all participants are evaluated. To view observations identified to have invalid data, click on Group Selection and Participants with Invalid Data. Values that are not
valid are shown in red. To view individuals previously selected by the Risk List function, click on **Participants in Risk List**. To restore to default, click on **All Participants**.

### 3.4 Individual Evaluation Menu

The **Individual Evaluation** menu provides a list of evaluations that can be done on an individual.

#### Monitor FEV₁ in an individual

1. On the **Individual Evaluation** menu click **FEV₁ Evaluation** to show a chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select the ID. Alternatively, type the ID into the **Search for Participant** box (see above).
The individual FEV<sub>1</sub> chart shows: the observed FEV<sub>1</sub> values (green dots) plotted against age; the linear regression line (green line) fitted to the observed FEV<sub>1</sub> data when at least 4 years of follow-up data are available; cross-sectional lower limit of normal (LLN), i.e., the lower 5<sup>th</sup> percentile (purple line) and the lower 0.1<sup>th</sup> percentile (comparable to 60% predicted) (orange line). The percentiles help to determine the probability with which an observed value is likely to occur in the reference population. U.S. population-based reference equations are used by default, but user can specify own equations (see Section 3.11). The blue solid line represents the limit of longitudinal decline (LLD<sub>r</sub>) calculated from the baseline observation(s). The default LLD<sub>r</sub> is based on ≈10% annual decline, i.e., the default relative within-person variation of 4% and reference slope of 40 mL/yr (see Section 5 and Section 3.11). This LLD<sub>r</sub> is used to identify excessive declines up to 8 years of follow-up. Observations that fall below LLD<sub>r</sub> should be evaluated as to whether the decline represents data quality issue or true decline. The turquoise (greenish-blue) dashed line represents the American College of Occupational and Environmental Medicine (ACOEM) longitudinal limit of decline calculated as LLD=Baseline FEV<sub>1</sub>×0.85- years×30 mL/yr, based on 15% annual decline. The user can select the ACOEM limit for decision-making by selecting LLD<sub>r</sub> of 15% and referential rate of decline of 30 mL/yr. See Section 3.11 on instructions how to change the default options.

Beginning with 4 years of follow-up, SPIROLA also tracks changes in the rate of FEV<sub>1</sub> decline and displays this against the scale on the right axis. The brown dots show the running rate of decline up to each data point and enable the user to discern the change in the rate due to the last data point. The yellow dots show the running change in the slope for the previous 8 years and enable the user to discern changes in the rate of decline in the last 8 years. The three parallel lines represent 30, 60, and 90 mL/yr rates of decline.
The bottom margin displays the linear Regression Slope and Within-person variation ($s_w$) for the individual who has 4 or more years of follow-up, and the mean Group Slope and mean within-person variation Group $s_w$, calculated as the averages of the individual linear regression statistics.

Beginning with 8 years of follow-up, SPIROLA’s decision-making is based on the estimated regression slope and the projected age when the regression (dashed green) line crosses the 0.1$^{th}$ percentile (dashed yellow line). The blue dashed line shows the longitudinal lower 95% confidence limit (CL) for the fitted regression line, estimated from 8 years of follow-up data. This limit can be used to test whether the last observation deviates significantly from the regression line predicted using all observations (Sections 4 and 5). To display the linear regression line extended beyond observed data, on the Option menu click Display, Curves, General, and Show projected regression line as shown below.

![Chart Display Options](image)

The table below the chart shows the individual’s demographic and lung function data at each test date. Other data, for example name, weight, smoking status, cigarettes per day, quality control data, and a technician’s code will be shown also if included in the SPIROLA database (see section 3.2).

**Monitor FVC in an individual**

1. On the Individual Evaluation menu click FVC Evaluation to show a FVC chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID. Alternatively, type the ID into the Search for Participant box.
The individual FVC chart shows: the observed FVC values (green dots) plotted against age; the linear regression line (green line) fitted to the observed FVC data (when at least 4 years of follow-up data are available); cross-sectional lower limit of normal (LLN) (purple line) and lower 0.1\textsuperscript{th} percentile (yellow line) (comparable to 60\% predicted), based on U.S. population-based reference equations.\textsuperscript{7} Observations that fall below LLN should be evaluated as to whether the decline represents data quality issue or true decline.

**Monitor percent predicted values in an individual**

1. On the Individual Evaluation menu click Percent Predicted to obtain a chart with percent predicted values for an individual person, as shown below.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID. Alternatively, type the ID into the Search for Participant box.
Display summary report

On the Individual Evaluation menu, click Summary Report to view results of an individual’s data analysis and suggested course of action, as shown below (see Section 4 on evaluation methods). Click Print to print the Summary Report (see Section 3.6).
Display multiple charts

1. On the **Individual Evaluation** menu click **Multiple Charts** and **Chart Options**. Select charts to be displayed together, as shown below, and click **Apply** and **Exit**.

![Individual Evaluation Charts](image)

2. On the **Individual Evaluation** menu click **Multiple Charts** and **View Charts** to display multiple charts, as shown below.

![Multiple Charts](image)
Search for an individual by name or identity number

1. On the Individual Evaluation menu click on Search for a Participant menu, as shown below.
2. Type the person’s name or identity number into the corresponding spaces and click on Find Participant. Alternatively, click on Find Participant, to list all individuals. After an individual is selected, click Apply, to see the selected individual’s evaluation.

3.5 Group Evaluation Menu

Group evaluation menu helps the user to monitor over time the following outcomes: longitudinal FEV₁ data variability (i.e., the pair-wise within-person variation); group means for FEV₁ and FVC; and the mean slopes of decline for FEV₁. All three charts can be displayed in one window.
Monitor longitudinal data precision in a group

1. On the Group Evaluation menu click on Within-person Variation to show the yearly values of the pair-wise within-person variation $s_p$ (absolute) and $s_r$ (relative), as shown below. The annual $s_p$ and $s_r$ statistics are calculated using FEV$_1$ measurements repeated within 18 months. If the number of repeated measurements is small (<50) in any one year, the $s_p$ and $s_r$ values are circled in yellow to indicate that the estimate may not be reliable. The legend at the bottom of the screen shows the mean $s_p$ and $s_r$ values for the program.

Monitor mean FEV$_1$ and FVC values in a group

1. On the Group Evaluations menu, click Means for FEV$_1$ (or FVC) to display yearly group means for observed, predicted, and z-score (standard deviation units from the predicted value) as shown below for FEV$_1$. 

---

SPIROLA Ver. 2.0
The mean FEV₁ chart shows group means for predicted (yellow), observed (green), and z-score (red) values. Same applies for FVC chart. The predicted values are derived from prediction equations that take into account age, height, sex, and race/ethnic background, and are based on nationally representative healthy never-smokers. Irregular deviations of observed mean values from predicted values may be due to changes in measurement procedures, or due to effects of occupational exposure or interventions. Monitoring group means can help to identify systematic effects taking place at a group level.

**Display multiple charts**

1. On the **Group Evaluations** menu, click **View Multiple Charts** to display the three group evaluation charts together (see example below). This allows the user to review changes in group FEV₁ and FVC means in relation to data precision.
3.6 Print Menu

1. To print a current plot, click **Print**, or **Quick Print** on the **Print** menu.
2. Evaluation results summarized in a medical report can be printed as individual charts or in the Multiple Chart option (see example below).
3. To preview the report, click **Print Preview** on the **Print** menu and a printable report will appear. Click one or two page display on the upper picture menu, as shown below.
3.7 Risk List Menu

Screen for individuals at risk of developing respiratory impairment

1. On the Risk List menu, click Show Risk List Summary to create a list of individuals whose rate of decline or within person FEV$_1$ variation has been identified as excessive or whose most recent lung function values (FEV$_1$, FVC, or the FEV$_1$/FVC ratio) are below LLN, as shown below. See Section 4 for the selection criteria.

![Risk List Menu Screenshot]

2. The results show the number of individuals screened and the numbers with each type of outcome. Click on Print Summary to print the summary statistics only.
3. To evaluate a subset of individuals with a specific outcome, select the appropriate outcome(s) shown under Select Participants With.
4. Click on Evaluate and select the method of evaluation from the Evaluation menus, or click on Print List to print the list.
5. To identify a particular individual from the selected subset, place a pointer next to a desired ID and click on Show selected participant evaluation.
6. To exit from the Risk List click on Exit.

3.8 Tag Menu

Tag individuals for further evaluation or intervention

1. On the Tag menu, click on either Quality Control to tag an individual for a review of spirometry tracings, on Re-Testing to re-test an individual in near future, or on Intervention to develop an intervention strategies for an individual. Click on Add Tag to add the person into a Tag List (see below).
2. To display the list of individuals included in to the Tag List, on the Tag menu click Tag List, and the list will be displayed as shown below.
3.9 Intervention Menu

Design and review intervention strategies and questionnaire data

1. On Tag List select a participant and click on Detail. An Intervention Summary window will appear, as shown below. To create a new questionnaire or an intervention plan, click on New Questionnaire or New Plan. The Questionnaire List and Plan List provide a history of previous records. Click on Edit to view the previous entries. To delete an entry click on Delete.

2. Click on New Plan to display the default intervention options, as shown below. Check on a selected intervention plan and click on View/Modify or Plan Detail to proceed with developing the intervention plan for an individual. Finally, Save the plan. To print a hard copy of the plan or to obtain a PDF file, click on Print Plan. To go back to the Intervention Summary function click on Exit. The intervention plan created for each individual will be permanently saved in the Administrative database “SPIROLA_Admin.mdb”. The user needs to safeguard the SPIROLA_Admin.mdb (see Section 3.2).
3. To modify an intervention plan template (i.e., to modify the questions that appear on intervention plans), click on **Intervention** menu and then on **Design Intervention Plan** as shown below.

The example below shows a template for the default safety intervention module. The user can change the description under each category, create new categories and subcategories, and change the type of data to be collected using the **Design Intervention Plan** menu by right clicking on subcategories and selecting from the options (i.e., **Add Subcategory**, **Modify Category**, or **Delete Category**). Changes to the templates are best done at the planning stage of the intervention program. Changes made once the data collection has started will make interpretation difficult, especially if new variables are created. When the changes are completed, click on **Save**. All changes made to the plan template will be saved permanently in the administrative database, which needs to be safeguarded.
4. To print blank questionnaire or blank intervention plan, on Intervention menu click on Print Blank Questionnaire or Print Blank Intervention Plan and print the file. If PDF writer software is installed on the computer (e.g., CutePDF Writer can be downloaded for free from www.cutepdf.com), then the documents can be saved as PDF files by selecting PDF Writer instead of a printer.
3.10 Quality Control Menu

Analyze quality grades assigned by a spirometer

1. On the **Quality Control** menu, click on **Quality Control Indices**, to obtain charts that evaluate quality grades assigned from each test session by a spirometer. The Quality Control charts are provided only if the quality grades are included in the SPIROLA database (see Appendix on dataset creation). The example below shows: the percentage of FVC (green line, square symbol) and FEV$_1$ (green line, circle symbol) tests that do not meet the ATS/ERS acceptability and repeatability criteria; the percentage of the tests that did not meet the ATS/ERS repeatability criteria for FVC and FEV$_1$ (blue lines); and the pair-wise within-person variation based on tests repeated within 18 months. The charts are done for all tests and by individual operators. This function is designed to monitor quality grades over time, overall and by individual technicians (operators).

![Quality Grade, Repeatability and Pair-wise Within-person Variation (%)](image)

3.11 Options Menu

List of options that can be changed from default

- a referential rate of decline based on the actual data;
- within-person variation based on the actual data precision;
- critical limit curves displayed on an individual chart;
- temporarily remove outliers from the individual data analysis;
- choose units for height (cm or in);
• customize the reference equations.

The **Option** menu allows implementation of some of the options.

**Referential rate of decline**

SPIROLA uses a default of 40 mL/yr for the referential rate of FEV\(_1\) decline. The **Referential Rate of Decline** option enables changing the default value. Studies indicate that the mean rate of FEV\(_1\) decline in healthy never-smokers is about 30 mL/yr. To achieve greater specificity of the limit of longitudinal decline (LLD) for moderate impairment of lung function, a referential rate of decline based on all healthy individuals regardless of smoking status, is used. In preliminary analyses, we determined this to ranges from 40 to 45 mL/yr. For guidance, SPIROLA calculates the mean rate of decline for the group using all individuals with four or more years of follow-up and shows the result on the bottom margin of individual FEV\(_1\) chart. Using the mean rate of decline as the referential rate of decline together with the program’s average within-person variation will result in identifying about 5% of declines as excessive.\(^5\)

On the **Options** menu, click **Referential Rate of Decline** and a dialog window will appear, as shown below. Select a desired value from the list box, click **Apply**. To reset back to default value of 40 ml/yr, click on **Reset to Defaults**.

**Within-person standard deviation**

SPIROLA uses a default relative within-person standard deviation \(s_r\) of 4% and the corresponding LLD, based on \(\approx10\%\) annual decline as being abnormal (see Section 5). When ATS/ERS recommendations on quality control are followed, workplace monitoring programs can achieve comparable data precision. These limits are goals that can help to achieve a satisfactory level of data precision.

However, if the relative within-person standard deviation \(s_r\), shown at the bottom of the **Group Within-person Variation** chart, is significantly higher/lower than the default
value of 4%, SPIROLA provides an option for changing the default value to the observed $\overline{s}_r$ value. If the $\overline{s}_r$ value is greater than 6%, then the LLD of 15%, which corresponds to the ACOEM limit, should be used and effort be made to improve spirometry quality.

1. On the Options menu, click Within-person Variation, and then click Relative Value or Absolute Value, and a new dialog window will appear, as shown below.
2. Click the arrow button of Within-person standard deviation or Longitudinal limit, and click on a desired value. If a desired value is not in the list box, enter the value.
3. Click the OK button to confirm the selection and Exit.

Critical limit curves

1. On the Options menu, click Display, and then click Curves. A new dialog window will appear, as shown below.
2. To enable or disable display of a critical limit curve, click the check box next to the name of each critical limit curve. By default, all curves are checked except Absolute LLD for FEV$_1$ and Show projected regression line for FEV$_1$ and FVC.
3. Click Apply to confirm the selections and Exit to exit this window.
Show height in inches or centimeters

1. By default, each individual’s height is shown in centimeters in the data table. To display height in inches, click Display on the Options menu, and then click Show Height in cm to remove the “check” mark.

Display values of an observation on the chart

1. Place the cursor on any data point on the longitudinal FEV₁ evaluation chart, and then right click. A small tooltip label will popup to show coordinates.
2. After a second, this tooltip label will disappear automatically.

Remove outliers from a longitudinal analysis

1. On the chart, place the cursor on any data point(s) which you want to temporarily remove while processing the data, and then right click. The data point(s) will be crossed out, and the regression line and other curves will be recalculated and redrawn. To reload a data point, right click and include the observation in the analysis.

Note: The deleted data points are not deleted from the dataset, but only from the current session. To permanently correct a data value, changes need to be done directly in the .mdb database.
Customize the reference equation for LLN and predicted values

1. On the Options menu, click Reference Equations to display a reference equation window (see below). By default, SPIROLA uses U.S. population-based reference equations based on NHANES III data.?

2. To customize the reference equations, select Custom Equation and type into the table user-specific regression coefficients that correspond to those provided in the equation above the table. If the equation does not include some specific parameters (e.g., weight), let us know. Click Ok and Exit to apply and save the new values.
4. Methods of Evaluation and Interpretation of Results

Interpretation and suggested actions

The table below summarizes “Results of analysis” and “Interpretation and suggested actions” sections in the Summary Report, according to the duration of follow-up. Individuals whose lung function is categorized as shown in the table are selected into Risk List (see below).

<table>
<thead>
<tr>
<th>Results</th>
<th>Interpretations and Suggested action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cross-sectional evaluation using the most recent spirometry results</strong></td>
<td></td>
</tr>
<tr>
<td>If any of the results below:</td>
<td>Examine spirometry quality and retest to confirm the results.</td>
</tr>
<tr>
<td>FEV₁&lt;LLN</td>
<td>If confirmed that FEV₁&lt;LLN, the person has FEV₁ value that has only 5% probability of being normal. If the results are confirmed, consider further evaluation, more frequent testing, and intervention.</td>
</tr>
<tr>
<td>FEV₁/FVC&lt;LLN</td>
<td>If confirmed that FEV₁/FVC&lt;LLN, results indicate airflow obstruction. If the results are confirmed, consider further evaluation, more frequent testing, and intervention.</td>
</tr>
<tr>
<td>FEV₁/FVC&gt;LLN and FVC&lt;LLN†</td>
<td>If confirmed that FEV₁/FVC&gt;LLN and FVC&lt;LLN, results indicate a low vital capacity. If the results are confirmed, consider further evaluation, more frequent testing, and intervention.</td>
</tr>
<tr>
<td>FEV₁&lt;0.1&lt;sup&gt;th&lt;/sup&gt; percentile</td>
<td>If confirmed that FEV₁&lt;0.1&lt;sup&gt;th&lt;/sup&gt; percentile, the person has FEV₁ value that has only 0.1% probability of being normal. If the results are confirmed, consider referral for clinical evaluation, more frequent testing, and intervention.</td>
</tr>
</tbody>
</table>

| Changes in FEV₁ over time with <8 years of follow-up | |
| FEV₁< LLDr | Examine the quality of baseline and current test. If confirmed that FEV₁< LLDr, the rate of decline may be excessive. |
| Rate of FEV₁ decline | Prior to 8 years of follow-up, excessive decline is evaluated using the LLDr limit. The rate of decline is provided as additional information from 4 years of follow-up, but is not used in SPIROLA’s decision making. |
| Within-person variation >250 mL | The within-person variation >250 mL can be due to lack of spirometry quality control. Consider correcting data errors before interpretation. Occupational exposure, asthma, or personal factors can increase FEV₁ variability. |

| Changes in FEV₁ over time with 8 or more years of follow-up | |
| FEV₁<95%CL (derived from the regression line) | If confirmed that FEV₁< 95%CL for the regression line, consider re-testing in near future. |
| Rate of FEV₁ decline >90 mL/yr. | If a rate of FEV₁ decline >90 mL/yr is confirmed, results indicate excessive FEV₁ decline. If the results are confirmed, consider further evaluation, more frequent testing, and intervention. |
| Within-person variation >250 mL | The within-person variation >250 mL can be due to lack of spirometry quality control. Consider correcting data errors before interpretation. Occupational exposure, asthma, or personal factors can increase FEV₁ variability. |
| Projected FEV₁ declines to 0.1<sup>th</sup> percentile before 70 years of age. | If projected FEV₁ regression line declines to 0.1<sup>th</sup> percentile (~60% predicted), results indicate increased risk of developing moderate impairment. If the results are confirmed, consider further evaluation, more frequent testing, and intervention. |
Risk List evaluation procedure

The Risk List identifies individuals who fulfill any of the criteria listed in the above table. In evaluating an individual identified to be at risk of impairment the following procedure should be considered.

1. Examination of the individual’s existing data
   (i) Examine the longitudinal demographic, FVC, and FEV₁ data shown on the screen in the table below the FEV₁ chart, to make sure that the data are reasonable.
   (ii) If a data point appears to be an outlier, temporarily exclude the point by right clicking on it and then evaluate the new results on the chart and in the report.
   (iii) If a single data point appears to be an outlier and causes the individual’s selection into the risk list, check for possible data errors. The first (baseline) observation may sometimes be lower due to the learning effect. When this happens, exclusion of the baseline value may improve precision of the interpretation.
   (iv) If a data error is found, correct the data in the .mdb database using Microsoft Access software, re-run SPIROLA, and review the new Summary Report.

2. Examination of the individual’s spirometry data quality
   (i) Examine the original spirometry tracings using the ATS standardization criteria of: (a) acceptability (extrapolated volume, cough in first second, end of test criteria, obstructed mouthpiece, extra breath, cessation of airflow); and (b) repeatability (≤150 mL) \(^9\)
   (ii) If an acceptability error is found, consider removing data for that test from the dataset, correct the SPIROLA .mdb file using Microsoft Access, and then re-run SPIROLA to produce a new Summary Report for the individual.
   (iii) Provide feedback to the spirometry technician(s) on the spirometry errors found.

3. Re-test the individual
   After the first two steps have been completed and SPIROLA still identifies the person as being at risk, consider re-testing the person within six months from the most recent test. If the re-tested spirometry values confirm the original interpretation, consider the suggested actions in the new Summary Report.

Suggested intervention measures

When spirometry quality issues are satisfied and re-testing confirms that a person has impairment or is at increased risk of developing respiratory disease, clinical evaluation, implementation of more frequent testing, and intervention measures should be considered. The severity of existing impairment and the rate of lung function decline should be considered when deciding on the type of intervention(s).

Interventions on an individual level:
Discussing lung function results with a worker can motivate the individual and can help to determine what course of action is acceptable to the individual to prevent further excessive lung function loss. Decreasing inhalation of noxious particulates and gases is usually the most important intervention. The most important risk factor for excessive
decline in lung function in smokers is often tobacco smoking, for which nicotine replacement therapy may provide best results for smoking cessation. Studies show that complete smoking cessation is needed to halt excessive lung function decline. Occupational exposures to respiratory hazards also represent an important risk. Evaluation of individual occupational exposures should be done. Where possible, hazardous exposures should be reduced or eliminated through engineering controls (e.g., substitution of less hazardous materials, process enclosure, workplace ventilation). Administrative controls (e.g., revised work practices) may also help limit hazardous occupational exposures. Finally, use of effective personal protective equipment (e.g., respirators) should be recommended when other measures are infeasible or insufficient by themselves. The potential synergistic effect of smoking and occupational exposure on increased risk of excessive decline in lung function should be explained to individuals who smoke and are exposed to occupational respiratory hazards. Weight gain can also contribute to lung function decline due to loss of fitness and difficulty in performing the spirometry test at full lung capacity. Body mass index (BMI) greater than 25 kg/m\(^2\) can be associated with greater decline in lung function when other factors such as gender, height, race, smoking, and respiratory symptoms, are controlled for.

Interventions at a company level:
Management commitment to an integrated worksite health and safety program provides a key foundation for success in maintaining a healthy workforce. Programs are likely to be more effective when they are based on management’s understanding of workers’ concerns about health risks on the job. By identifying workers’ priorities, smoking (for example) can be addressed in the broader context of worksite safety. Intervention at the individual level is then more likely to be successful.

Evaluation of the effect of intervention(s):
To determine the effect of individual intervention on the rate of FEV\(_1\) decline using SPIROLA, use the small rate of decline chart on the individual FEV\(_1\) evaluation. To determine the effect of an integrated worksite health and safety program using SPIROLA, assess trends on the FEV\(_1\) and FVC means for the whole group and for the at-risk subgroup. An expansion of this feature is planned for a future version of SPIROLA.

5. Theoretical Background

The use of SPIROLA may help preserve lung function by:
(i) evaluating longitudinal data precision and promptly identifying when intervention is warranted to maintain data precision at an acceptable level;
(ii) identifying individuals with excessive decline in lung function using limits of longitudinal decline (LLDr) based on the program’s actual data precision, or if data precision can not be determined, based on the default criteria (i.e., \(s_r=4\%\) or LLDr=10\%) or the ACOEM longitudinal limit criteria (i.e., \(s_r=6\%\) or LLDr=15\%);
(iii) identifying individuals who already have lung function impairment using ATS/ERS criteria based on cross-sectional data evaluation;
(iv) identifying when an individual’s lung function warrants individualized intervention measures;
(v) evaluating the effects of intervention at the individual level and the group level.

**Evaluation of FEV\(_1\) precision in a group**

Monitoring a program’s data precision on an annual basis can help to identify and address data quality problems soon after these occur and this way achieve and maintain high data precision. To monitor data precision, SPIROLA calculates and charts yearly values of the absolute *within-person standard deviation* \(s_p\) and the relative *within-person standard deviation* \(s_r\).\(^{4,6}\) These statistics are calculated on a yearly basis as the difference between FEV\(_{1i1}\) and FEV\(_{1i2}\) measured within 18 months of each other and summed over \(i = 1, \ldots, n\) individuals. (Note: this is not within testing session variance.) The year of the first measurement determines the assigned year. A sample of about 50 individuals with repeated measurements is needed to obtain a reliable estimate of yearly FEV\(_1\) variation.

The absolute within-person standard deviation \(s_p\) for a specific year is defined as:

\[
s_p = \sqrt{\frac{1}{2n} \sum_{i=1}^{n} (\text{FEV}_{1i1} - \text{FEV}_{1i2})^2}
\]

The relative within person standard deviation \(s_r\) adjusts for each individual’s FEV\(_1\) size and for a specific year is defined as:

\[
s_r = \sqrt{\frac{1}{2n} \sum_{i=1}^{n} \left( \frac{\text{FEV}_{1i1} - \text{FEV}_{1i2}}{\frac{\text{FEV}_{1i1} + \text{FEV}_{1i2}}{2}} \right)^2}
\]

The average values \(\bar{s}_p = (1/kN) \sum (s_p/n)\) and \(\bar{s}_r = (1/kN) \sum (s_r/n)\) are calculated by summing the yearly weighted \(s_p\) and \(s_r\) values over all years of follow-up and then dividing by the total number of repeated observations \(N\). These values represent the average program-specific absolute and relative within-person variation, respectively. The \(\bar{s}_p\) and \(\bar{s}_r\) values are shown at the bottom of SPIROLA’s Group Within-person Variation chart as ‘Mean \(s_p\)’ and ‘Mean \(s_r\)’. The mean within-person standard deviations \(\bar{s}_p\) and \(\bar{s}_r\) can be used to derive the program-specific *limits of longitudinal decline* (LLD) by substituting these for the default values on the **Options** menu under **Within-person Variation** option. When annual measurements are not available, SPIROLA provides the group average within-person variation **Group \(s_\alpha\)** estimated from the linear regression analysis done on each individual’s data from 4 years of follow-up. Generally there is good agreement between these two methods of estimation.
Note: If the sample of measurements repeated within 18 months is less than 50, the $s_p$ and $s_r$ values are considered unreliable and are indicated by a yellow color. If $\bar{s}_p$ and $\bar{s}_r$ values are not displayed or are based on a sparse sample, the user could use the default LLD value of 10% or change the default to LLD of 15% as based on the ACOEM limit.

**Estimation of limits of longitudinal decline for an individual**

Because of inherent FEV$_1$ variability, it takes approximately 5-8 years of follow-up to obtain a reliable estimate of the rate of FEV$_1$ decline in an individual.$^{4-6}$ To identify individuals with an excessive FEV$_1$ decline within the first 8 years of follow-up, SPIROLA uses by default the relative limit of longitudinal decline (LLD$_r$),$^6$ but the absolute limit (LLD$_a$) or the ACOEM limit based on 15% can also be used. These limits are applied to determine whether the lung function decline between the baseline FEV$_1$ value (or a mean of the first two observations, if the first FEV$_1$ value is lower than the second one) and each follow-up FEV$_1$ value is excessive. Observations that fall below the LLD warrant concern. The absolute or relative longitudinal limits are calculated using a default value based on 10% annual decline. The user may change this to reflect the average within-person FEV$_1$ variability for the group or the ACOEM limit based on 15%.

The absolute limit of longitudinal decline LLD$_a$ (mL/yr) is defined as a one-sided 95% confidence limit:

$$LLD_a = t \times (b + 1.645 \times SE(b))$$

where $t$ is the duration of follow-up in years and $b$ is either the referent slope of decline (up to 8 years of follow-up) or the individual’s estimated regression slope (beginning with 8 years of follow-up). SPIROLA uses a default referent slope of decline of 40 mL/yr based on an analysis evaluating performance characteristics of the limit with respect to sensitivity and specificity for long-term excessive decline in FEV$_1$ of $\geq$90 mL/yr and FEV$_1 \leq$60% predicted. The standard error of the slope $b$ is defined as

$$SE(b) = \sigma_w \sqrt{\frac{12(P-1)}{t} \frac{1}{P+1}}$$

where $t$ is the duration of follow-up in years, $P=2$ represents two repeated measurements done during the follow-up time $t$ (the baseline and last observation), and $\sigma_w$ is the within-person standard deviation. By substituting the program-specific pair-wise estimate of the within-person standard deviation $\bar{s}_p$ for the within-person variation $\sigma_w$ in equation (1), one can estimate program-specific absolute LLD$_a$.

The relative limit of longitudinal decline LLD$_r$ (%) standardizes for the magnitude of FEV$_1$ and is defined as:

$$LLD_r = t \times \left(\frac{b}{FEV_{1b}} + 1.645 \times SE_r(b)\right)$$
where \( \text{FEV}_{1b} \) is the program-specific mean baseline \( \text{FEV}_{1} \), and \( \text{SE}_{b}(b) \) is the approximate standard error of \( b/\text{FEV}_{1b} \) calculated by substituting the program-specific relative within-person standard deviation \( \bar{s}_r \) for \( \sigma_w \) in equation (1).

The limit for the actual value of \( \text{FEV}_{1} \) (mL) below which an individual’s \( \text{FEV}_{1} \) should not decline after \( t \) years of follow-up without raising concern can be calculated in terms of the individual’s baseline \( \text{FEV}_{1b} \) value and \( \text{LLD}_a \) or \( \text{LLD}_r \), as follows:

\[
\text{FEV}_{1} = \text{FEV}_{1b} - \text{LLD}_a
\]

or

\[
\text{FEV}_{1} = \text{FEV}_{1b} - \text{FEV}_{1b} \times \text{LLD}_r
\]

SPIROLA’s default value for the relative within-person variation \( \bar{s}_r \) is 4\%, which corresponds to \( \text{LLD}_a \) of 10\% for \( t=1 \) (i.e., annual follow-up). The \( \text{LLD}_r \) of 15\% for \( t=1 \), which corresponds to the ACOEM limit, is based on \( \bar{s}_r \) of 6\%. To change this default value, on the Options menu use the Within-person Variation option. Beginning with 8 years of follow-up, the interpretation of excessive decline is based on an individual’s regression slope and the lower 95\% confidence limit around the regression line calculated as above. Here \( b \) represents the estimated regression slope and the individual’s baseline measurement \( \text{FEV}_{1b} \) is replaced by the individual’s predicted \( \text{FEV}_{1} \) value.

**Cross-sectional evaluation to identify respiratory impairment**

SPIROLA evaluates and reports for the most recent spirometry test whether the \( \text{FEV}_{1} \), FVC, or \( \text{FEV}_{1}/\text{FVC} \) ratio values are below the respective “cross-sectional” lower limit of normal (LLN) values or whether the \( \text{FEV}_{1} \) value is below 0.1\textsuperscript{th} percentile. This approach defines the individual’s value in terms of the probability of being normal based on population distribution for individual’s characteristics (i.e., age, height, gender, ethnicity or race). By default, the LLN values and the predicted values are calculated using the U.S. population-based reference equations estimated separately for Caucasians, African-Americans, and Mexican-Americans. However, user-defined reference equations for \( \text{FEV}_{1} \), FVC, and the \( \text{FEV}_{1}/\text{FVC} \) ratio can be specified.

**6. References**


**Appendix**

**Software requirements to run SPIROLA**

- Microsoft Windows 2000/ XP/Vista
- Microsoft .NET Framework 2.0 and Database engine. In most cases these software packages are already installed on the user’s computer.
- Microsoft Access 2003/2007 for viewing or editing data in Microsoft Access format.

If the .NET Framework version 2.0 redistributable package is not already installed on the computer, it can be installed by running the program DOTNETFX.EXE provided in the SPIROLA software package or it can be obtained as a free download from following link: http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en